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Introduction 
 
A MIDI Foot Controller (MFC) is a device used to control musical equipment via a MIDI connection.  These foot controllers are commonly used by guitarists to 
select sounds and effects in digital guitar processors.  MFCs have button footswitches with built-in and/or externally connected pedals. 
 
The basic process is that you use the editor design your own foot controller layout and features and test it in the emulator.  Finally, you load both your 
settings and firmware onto your BJ Devices MFC. 
 
This manual describes the Version 5 GM Arts settings editor, emulator and firmware for BJ Devices MIDI Foot Controllers.  Version 5 is primarily designed for 
Mark II MFCs, however, you can also save an extract for small setups that will work with the original MFCs. 
 

GM Arts Firmware 
This firmware allows you to set any footswitch to operate any function on any of the currently available BJ Devices TB MIDI Foot Controllers.  Here are the 
main features: 
 

• Supports all BJ Devices models: TB-5, TB-6P, TB-8, TB-11P & TB-12 

• Supports BJ Devices BS-2 up/down footswitches (aka stand-in switches) 

• 8 footswitch pages (aka layouts) per model 

• Each footswitch has a main function and optional hold function 

• Pedals can have dual functions 

• Up to 25 banks for patch footswitches with 10 patches per bank (max 250 MFC patches) 

• Patch backtracking 

• Up to 100 effects, with options for "multi-effects" 

• 4 effect types: toggle, select, momentary, and toggle can act as momentary if held down 

• 25 effect groups 

• Up to 25 steppers (for 3-way switches, up/down effects and more) 

• Up to 25 control pedals 

• Patches, effects and steppers can send any MIDI messages as well as MFC commands 

• Footswitches and pedals can be overridden on a per-patch basis 

• Supports Fractal Axe-FX models Axe-FX II, Axe-FX II XL, Axe-FX II XL+, Axe-FX III  



MIDI Messages 
 
There are many types of MIDI messages that the MFC can send to connected equipment, but the messages most commonly used are: 
 

• PROGRAM CHANGE (PC) is used to change presets on a digital processor.  For example, this might change from a clean Fender preset to an overdriven 
Marshall preset. 
 

• CONTROL CHANGE (CC) is used to modify the sound of a patch.  For example, a footswitch could turn an effect such as reverb off and on.  Likewise, a 
pedal could send CC messages to control the volume level of a patch. 

 
All MIDI channel messages and system exclusive messages are supported.  You will need to consult the documentation for your MIDI equipment to get the 
most from your MFC. 

 

What's Included 
 
Included files:  

• A PC editor application to create, edit and backup your own settings files 
• The editor includes a built-in MFC emulator allowing you to test settings from your PC 
• Firmware for each TB Mark II model 
• Firmware for each original TB model (for use with settings exported from the editor) 
• A sample settings file for all TB models 

 
The editor installation should download Microsoft .NET framework version 4.7.2 if you don't already have it, but if you have problems, you can download it 
manually here: 
 https://support.microsoft.com/en-us/help/4054530/microsoft-net-framework-4-7-2-offline-installer-for-windows 
 

What You Need 
 

• A BJ Devices MIDI Foot Controller 

• A Windows PC to run the editor 

• For Mark II MFCs, you'll also need a MIDI interface for your PC and its software driver installed.  The editor sends your settings to the MFC via this 
interface.  There are many types available; I use the Roland UM-ONE which connects from PC USB to MIDI in and out. 

https://support.microsoft.com/en-us/help/4054530/microsoft-net-framework-4-7-2-offline-installer-for-windows


Loading the MFC 
 

Downloads 
 

Download the firmware and editor from http://www.gmarts.org/tb2/ - this is a ZIP file, so you will need to use (or download) a program to extract files from 
this download.  Run the file "setup.exe" to install the Editor. You may see warnings about "unknown publisher" because I don't use a certificate at this stage. 
 
To use this firmware, you need to load 2 things into your MFC:  
1. Firmware, loaded with the "Chip 45" tool - the firmware does NOT have a built-in editor 
2. The settings you've created with the Windows Editor - these are loaded via MIDI for Mark II MFCs, or with the "Chip 45" tool for original MFCs 
 
The settings should be saved with the editor that has the same version number as your firmware. 
 

Loading Firmware and Settings - Mark II Models 
 

Firmware and settings need to be loaded into your BJ Devices Mark II MFC:  
 
The firmware is a file that ends with ".hex".  Make sure to choose the MARK II firmware that matches your MFC model.  Firmware controls how the MFC 
works. You can always go back to BJ Devices factory firmware if you wish.  Firmware is loaded from your PC to the MFC via USB using the "Chip 45" software 
described in BJ Devices documentation here:  http://bjdevices.com/wiki/doku.php?id=user_guide#firmware_update 
 
The PC editor is used to create, save and modify your own settings.  Settings saved by the editor use a file ending with ".tb2".  The editor also sends your 
settings to your MFC via a MIDI interface.  When you have your settings ready to use, follow these steps to send them to your Mark II MFC: 

 
1. Connect your PC's MIDI interface OUT to the MFC's MIDI IN socket 
2. On the editor File menu, select "Send Settings to MFC MARK II", and select your MIDI output on the "Send Settings" dialog box 
3. Power on your MFC and press the MFC's [DOWN] button before pressing any footswitches.  The MFC display will show "Ready for import"  
4. Click [START] on the PC's dialog box.  Your settings will load in a few seconds. 
5. Press [LOAD/OK] on the MFC to start using your new settings 

  

http://www.gmarts.org/tb2/
http://bjdevices.com/wiki/doku.php?id=user_guide#firmware_update


Loading Firmware and Settings - Original Models 
 

BJ Devices original TB models have less memory available for settings, so the first step is to find out if your settings fit.  On the editor's File menu, select 
"Export Settings for Original …".  A dialog box shows if your settings fit, with some tips for saving space.  If your settings are too big, you can save a separate 
copy of your settings, then take out anything you don't need, and try the export again.  When you're ready, save the export - it has a file extension of ".eep".  
 
There are 2 files that need to be loaded into your original BJ Devices MFC:  
 
The firmware is a file that ends with ".hex".  Make sure to choose the ORIGINAL firmware that matches your MFC model.  Firmware controls how the MFC 
works. You can always go back to BJ Devices factory firmware if you wish.  Firmware is loaded from your PC to the MFC via USB using the "Chip 45" software 
described in BJ Devices documentation here:  http://bjdevices.com/wiki/doku.php?id=user_guide#firmware_update 
 
Next, load your exported settings ".eep" file with the same Chip 45 software and restart your MFC. 

Workflow Diagram 

 

http://bjdevices.com/wiki/doku.php?id=user_guide#firmware_update


MFC Basics 
 

  

MFC Connections 
 
1. Connect a MIDI cable from your MFC MIDI OUT to your musical device's MIDI IN. 
2. If you have an Axe-FX II and wish to use those features on you MFC, connect another MIDI cable from your Axe-FX MIDI OUT to the MFC MIDI IN. 

Make sure that your Axe-FX is set to send both tuner and tap MIDI messages. 
3. Optionally connect one or both pedals to the MFC. 
4. Then connect power to your MFC. 

 

 

MFC Display 
 
The editor shows a sample of your MFC display on the Global Display tab.  You can show page, bank and patches at the left of the display, effect 
abbreviations at the right of the display, with the centre of the display showing page, bank or patch names.  There are additional options for Axe-FX 
owners. 
 
Also, when pressing a footswitch, its function is shown on the top line of the display.  The Axe-FX can show its tuner on the bottom line of the MFC display. 
 
 
 

  



Using the Editor - Getting Started 
 
When you open the editor, you'll see this screen.  This is the footswitch Layout page and is what you'll use most often after you've created and saved your 
first settings.  But for first time use, we need to check some default settings on other tabs. 
 

 
 



Here are the main steps for your first use of the editor.  Most of this preparation will only need to be done once.  You can find details for each tab further 
below. 
 
1. Select your MFC Model by using the dropdown list on the toolbar.  For this example, we'll choose the TB-11P.  You can actually make settings for every 

TB model in the same settings file, but it's best to work with one at a time. 
 
2. Select the Global tab and check the default MIDI settings: 

 

 
 

  



3. Select the Global Pedals tab and check your connected pedal types are correct.  It’s important to set this before assigning pedals later on the Layout 
tab. 

 

 
 

4. If you have an Axe-FX, select your model on the Axe-FX tab 
 

  



5. Now go to the Effects tab and add effects that you use.   You can modify and remove existing effects if necessary, but the tap effect cannot be deleted.  
Set the effect type on this tab as well. Most effects will probably be regular Toggle types (stomp-box style: press to turn on, press again to turn off).   

 

 
 
6. Also set up any Steppers and Pedals you need to use. 

 
Now you can use the Layout tab to assign your effects to footswitches. 

  



Layout Tab - Default Settings 
 
The first tab is Layout which allows you to assign a function to each footswitch.  Labels are shown for each of the footswitches available on your MFC 
model.  When you start a new file, all footswitches are set to "None".  Click a footswitch label to assign functions. 
 
Some MFC models have an on-board pedal with a footswitch under the toe end of the pedal.  For those models, you'll see an "Under Pedal" label. This 
refers to the footswitch under the pedal, not the pedal itself.  Pedal functions are also assigned on this tab. 
 

 
 



Click one of the footswitches to see a popup menu of footswitch choices.  This selects the main footswitch function.  When a main footswitch is assigned, 
you'll see an additional option for a hold footswitch. You can set the time required for a hold footswitch on the Global Defaults tab. 
 
This example shows all main footswitches and pedals assigned, with footswitch 6 having a hold function as well. 
 

 
 



Footswitch Functions 
 

PATCHES 

This refers to MFC patches.  There are up to 250 available MFC patches in 25 banks of 10 patches each.  Banks are labelled A, B, C, …, to Y.  A MFC patch 

typically sends a MIDI Program message to select a preset on connected equipment.  Footswitches can have the following patch assignments: 

• Select a patch number from 0 to 9 in the current bank 

• Select a specific bank and patch (and optionally change bank at the same time) 

• Patch Up and Down - see the Global Defaults section for details on how Patch Up/Down works with bank selections 

• Patch Backtrack - go to the last used patch 

• Patch Reset – selects the current patch again with the usual effect, stepper & control pedal resets and messages 

 

EFFECTS & STEPPERS 

Just select an effect from the popup list. 

 

BANKS 

• Select an available bank A, B, C, etc 

• Bank Up and Down 

• Bank Now - returns to the bank of the current patch, even if you've since selected a different bank 

• Previous Bank returns to the previous bank 

• Bank +1 Toggle - this allows you to use a single footswitch to toggle between 2 banks 

 

  



PAGES 

• Select Page 1 to 8 

• Page Up and Down 

• Previous Page 

 

Footswitch LEDs 
 

Footswitch LEDs show the main footswitch function as well as any hold function the footswitch may have. 

• If both the main and hold footswitches are off, then the LED is off 

• If the main footswitch is on and the hold footswitch is off, the LED is on 

• If the hold footswitch is on and the main footswitch is off, the LED flashes slowly 

• If both the main and hold footswitches are on, the LED flashes quickly 

Note that the Tap footswitch only shows the main footswitch LED, because it can also be flashed by the Axe-FX tempo.  Also, if a footswitch shows a Page 

LED and also has a hold function, only the Page LED displays. 

 

Here are the footswitch LED colours: 

• Patch LEDs are red 

• LEDs for effects that are not in a group are green 

• Effect group LED colours are set on the Global Display tab 

• Bank select and toggle LEDs are yellow 

• See the Steppers section for information on Stepper LED colours 

• Footswitches that don't use a LED can show a colour to indicate the current page 

 

  



Hold Functions 
 

Footswitches can have 2 assignments: a main function that happens when you press and release the footswitch quickly, and a hold function that happens 

when you press and hold down the footswitch.  You can set the footswitch hold time from 0.3 sec to 2 seconds on the Global Defaults tab. 

When you assign a hold footswitch, there are 2 hold types available: 

• "And Hold …" means press footswitch for the main function AND optionally hold footswitch down for the hold function as well 

• "Or Hold …" means press & release footswitch for the main function OR hold footswitch down for the hold function instead 

There are some situations where you won't see these options: 

• A patch hold footswitch is always "or hold" 

• A momentary (or toggle-momentary) effect as a main footswitch forces the hold footswitch to be "and hold". 

• A bank main footswitch with a bank hold function is always "or hold" 

• A page main footswitch with a page hold function is always "or hold" 

When you press a footswitch, you'll see a description of its function on the top row of your MFC's LCD.  If the footswitch also has a hold function available, 
you'll see a small "H" at the left top of your display to indicate that another function is available if you hold down the footswitch.  You might want to take 
this into consideration if you're assigning hold footswitches placed above the LCD, because your foot will obscure the display. 
 
A hold function activates: 

• When the hold time is reached for page changes, momentary effects and bank changes that don’t also select a patch 

• When you release the footswitch for other functions that affect your sound: patch selections, steppers, non-momentary effects and bank changes 
that also select a patch 

 

A and B Pedals 

Pedals are also assigned on the Layout page.  Pedals can have an A and B assignment.  When you select a patch, pedals are set to their A assignment.  

Effects can toggle a pedal between A and B.  When assigning pedal B, there is an option to have both A and B pedals working together, which can be useful 

if you need to control multiple MIDI devices on different MIDI channels. 

 



Other Layout Options 
 

You can name pages on the Layout tab.  You can also choose a Bank for the current page - it will be set whenever you go to this page.  There are options 
to clear all default footswitches, copy footswitches (including their overrides) from other pages, and also to rearrange the page order. 
 

Layout Tab - Overrides 
 

 What are Overrides? 
 

Overrides allow you to change your footswitches and pedals on a per-patch basis.  For example, if your normal overdrive effect is on footswitch 3, you 

could change it to a compressor effect just for patches A3, B7 and C8. 

Patches already have their own individual settings and custom messages, and it doesn't make much sense to have a per-patch override change the patch 

footswitch itself, so patch footswitches cannot be overridden, and you cannot override a footswitch with a patch. 

An override group applies to one or more patches, and changes the default assignment for one or more footswitches/pedals. 

 Setting Overrides 
 

I recommend that overrides are the very last thing your set up when making your MFC settings.  You will need to have your default footswitches 

completely set the way you want before deciding which patches need different footswitches. 

On the Layout select the Override option.  You'll see a dialog box where you can choose one or more MFC patches that will have different footswitches.  

From there you just click on footswitch and pedal labels to assign whatever you need for this override group. 

Overrides are footswitch changes for selected patches, so patch selection footswitches cannot be overridden, but otherwise there are few restrictions.  

Obviously, if you override just a main or just a hold footswitch, it needs to be compatible with the default footswitch. 

To add another override group, click [New] to select other patches you want in this particular override.  If you can't choose a certain patch, it means it's 

already used in another override, so click [Find Patch] to then [Change] that override if necessary.  



Patches Tab 
 

The patches tab is used to create the banks you need, and to name both banks and patches.  The main setting you need to check on this page is the Program 

Change Number.  This controls which preset is recalled on your connected MIDI device. 

 



There are other options on this page for you to use a different MIDI channel or not use program changes at all, or use messages instead for complete control 

over your MFC patch selections. 

Patch changes can use default messages - these apply to all patches that have “default messages” selected.  For example, you might usually want to select a 

particular scene or mode when you select a patch, so use a default message for this purpose. 

Custom messages apply to only the displayed patch.  This prevents default messages being sent and sends the custom messages instead.  Another option is to 

select custom messages but use no messages.  In this case, it just prevents default messages being sent. 

See the Messages section later in this guide for information on how to add, edit and use messages. 

Selecting a patch sends messages in this order (for those items that are configured): 

1) MIDI MSB and LSB, then MIDI Patch Change 
2) Pause* 
3) Default or Custom MIDI messages - only MIDI messages are sent at this stage, MFC Commands are sent later. 
4) Effect, Stepper and Pedal resets for those that are NOT included in default or custom messages. 
5) Set relays* - Four relays can be set off or on to control non-MIDI equipment connected to the 'Fsw' sockets. 
6) Default or Custom MFC Command messages such as setting effects off or on, changing bank or going to a page, etc. 
7) Axe-FX requests* 
* These are set on the Global tab 

 

If you select the current patch again, there are options to … 

• Reset the current patch.  This works as if you are selecting the patch for the first time, by sending the same patch messages, effect resets, etc. 

• Backtrack - selects the previous patch used. 

• Toggle between this patch and another patch of your choosing.  Note that footswitches can have a main and hold function, so if you use both these 

footswitch options with patches that toggle, you can actually choose 4 different patches from just one footswitch.  Using a toggle patch on a hold 

footswitch is a little awkward, so I recommend just a normal patch on the hold footswitch, so 3 patches on one footswitch is a more practical option. 

• Control an effect – this can toggle an effect off and on, or just send on messages for a select effect - see below 

 

The usual option is to reset the patch to its original effect states, but you can also backtrack to the previous patch, toggle between this patch and another 

(such as a favourite patch), or operate an effect (toggle or select effect types). 



A powerful option for "Control an effect" is to toggle a single effect that controls the state of multiple effects.  This is like scenes in the Axe-FX (but you're not 

limited to 8 scenes).  This way you can select a patch for its normal sound then continue to select the same patch again to toggle an effects combination off 

and on.  See "Multi Effects" in the Effects section of this guide for more information. 

Note that patch footswitches always show their red patch LED, even if they control an effect when re-selected.  Effect abbreviations can be used to show any 

effect state on the MFC display. 

There is an option on the Bank menu to arrange the order of banks.  When changing bank order, default bank names (such as "Bank C") and default patch 

names (such as "Patch C5") are renamed in alphabetic order so they still display in Bank A, B, C, … order. 

  



Effects Tab 
 
This is where you'll spend most time setting up your effects to work with your connected MIDI equipment.  Adding effects here only makes them available for 
use; they need to be assigned to a footswitch on the Layout tab to control your effects. 
 

 
 



Effect Types 
 
Choose the type of effect that matches the way the effect works.  It will help to make this selection before assigning footswitches, because some effect type 
changes can force changes in your layout. 
 
TOGGLE and TOGGLE-MOMENTARY 
 
Toggle works like a typical stomp-box: Press to turn the effect ON, then press again to turn the effect OFF.  There is also a "toggle-momentary" option when 
turning an effect ON and holding the toggle footswitch down for the footswitch hold time, then you can release it to turn the effect OFF.  This only applies 
when the footswitch is a main effect, and not a hold effect. 
 
SELECT 
 
Whenever you press a SELECT footswitch, it sends the effect ON messages.  You normally have several select footswitches in the same effect group, so that 
pressing another footswitch in the same group will first send OFF messages for the current effect, then send ON messages for the new effect.  Select effects 
are typically used for effects that you only turn on, such as scenes (aka snapshots), and looper controls. 
 
MOMENTARY 
 
Press the footswitch to turn ON, release to turn OFF.  These are ideal for effects that you use briefly.  The Tap effect is also set up as a momentary effect and 
cannot be deleted.  It can also be used for momentary effects while held down.  Momentary effects can only be assigned as main footswitches, not hold 
footswitches. 
 

Effect Groups 
 
There are 25 groups available labelled A, B , C, … Y.   Both Toggle and Select effects can be in a group.  Only one effect can be ON in a group at any time, so 
when you turn an effect in a group ON, it first turns OFF any other effect in the same group that is currently ON.  There is an option on the Global Display tab 
to set LED colours for each effect group. 
 
This is ideal for scene selections, because only one scene can be on at a time, and the MFC LEDs will show which scene is currently active.   It can also be used 
for similar toggle effects that you wouldn't normally use together, such as possibly a phaser and chorus effect.  For example, if you have the phaser effect ON, 
then turn on your chorus effect, having them in the same effect group will automatically turn off the phaser as well. 
 



Effect Groups can also be used for different effects that are used (with overrides) on the same footswitch.  That way you can use a single location on the LCD 
to show an effect abbreviation for whichever effect is on for that footswitch. 
 

Effects When Selecting a Patch 
 
These options control what happens to each effect when you select a MFC patch.  You can choose for the effect to be OFF, ON or PERSISTENT (no change).  
You can also set whether the effect off/on message is sent with the patch change. 
 
These are just default settings; you can use messages for each patch on the Patches tab to change the way these effects reset.  See the Axe-FX Tips section for 
details on synchronising your Axe-FX effect states, effect channels and scenes with the MFC. 
 

Other Effects 
 
Select and momentary effects that are assigned as a main effect (not a hold effect) can turn on a 2nd effect after a certain number of presses.  For example, a 
Tap footswitch could automatically turn on a Delay effect after 2 short-presses (when you release the footswitch before your hold time).  Click the 2nd effect 
label to choose which effect you want to use. 
 
Another example is to combine a momentary effect control switch that you hold down (for example, to change a Leslie effect from slow to fast) that also 
turns on an effect after 1 short-press.  With these examples, you’d also want a way to turn 2nd effects off, and this could be done with a patch selection that 
resets effect, or scene changes for Axe-FX owners. 
 
Momentary effect footswitches don't show a LED because the effect is OFF when you release the footswitch.  However, if a momentary effect turns on a 2nd 
effect, the LED will light when the 2nd effect is on.   
 
Turning an effect off and on can also change a pedal from its A setting to its B setting.  A and B pedals are assigned on the layout tab.  For example, Pedal #1 
might be set to control Volume with the A setting and Wah with the B setting.  Turning on a Wah effect could automatically change the pedal from Volume to 
Wah.  An effect cannot change a pedal from A to B if the same effect is used as a controller auto-effect (see the Pedals tab). 
 

Effect Abbreviations 
 
Each toggle and select effect has an abbreviation.  These can be shown on the MFC display and is useful to see which effects are on, even if they're controlled 
by footswitches on a different page.  Use the Global Display tab to customise which effects show their abbreviations. 



 
 
Because you can use the ON and OFF messages to send any CC values you want, you can also set effects to work in reverse.  For example you might use an EQ 
effect to cut mids and volume level for a rhythm sound, but you want it to show as ON for soloing when the effect is off.  Check "Display OFF as ON" to 
reverse the footswitch LED and abbreviation displays.  This applies only to toggle effects that are not in a group. 
 
 

Effect Messages 
 
See the section below on how to customise messages.  When you add an effect, you'll need to enter a CC number that matches the same effect in your 
connected MIDI equipment. 



Multi Effects 
 
A single effect can turn any number of other effects off and on so you can get your sound with a single footswitch press.  Add messages that turn other 
effects off or on.  You could even use several Multi Effects in the same effect group that each control different effect combinations.  Here's the multi effect 
from the settings example file in the download - it uses a toggle type with messages to turn both overdrive off and on at the same time, while making sure 
that Chorus is always off. 
 

 

  



Steppers 
 
Steppers have UP and DOWN footswitches that are used to move up and down through various settings.  They have lower and upper limits and also a start 
value.  A stepper footswitch LED is: 

• OFF when the stepper value is the start value 
For STEP DOWN footswitches 

• GREEN when the stepper value is between the start value and the lower limit 

• RED when the stepper value is at the lower limit 

• YELLOW when the stepper value is above the start value 
And opposite for a STEP UP footswitch: 

• GREEN when the stepper value is between the start value and the upper limit 

• RED when the stepper value is at the upper limit 

• YELLOW when the stepper value is above the start value 
 
Here's a diagram of how the LEDs work for step UP and DOWN footswitches: 

 
 
 
Steppers can be used in several ways: 
 
MULTIPLE STEPS 
 
When you open MFC Edit, there is an example of a Volume stepper.  This steps a volume CC (number 7) from value 0 (off) to 127 (maximum), stepping 16 
values at a time.  So this would give you 8 steps from off to maximum.  Stepper up and down footswitches work like moving a volume pedal up and down, but 
just stopping at certain positions. 



 
You could use custom messages instead of CCs to make a very flexible volume switcher.  For example, you might want to use CC values 127 for maximum 
boost, 120 for solos, 100 for rhythm and 0 for off.  Select custom messages, set an upper limit of 4 for the 4 messages, then enter the CC messages you want 
for each step. 
 
WRAP-AROUND 
 
There is also an example of a scene selector when you open MFC Edit.  Use the limits to select a range of scenes you wish to use, and wrap-around allows you 
to move between the lowest to highest values. 
 
3-WAY and 4-WAY SWITCHING 
 
If a stepper has three or four steps with wrap-around, you can use a single stepper footswitch (such as Up) to cycle through the each setting.  Each of these 
steps will show a different LED colour, as shown above. 
 
 



 
 

Stepper Messages 
 

The MIDI CC option works like a control pedal, simply sending a CC value for each step.  You can add additional messages if necessary.  The Custom messages 
option allows up to 15 steps where each step sends a different message (or group of messages).  See the messages section below for more information.  



Control Pedals 
 
This tab is used to set control pedal functions that can be assigned to pedals on the Layout tab. 

 



MFC pedals can be disabled on the MFC itself which is useful if a pedal cable fails for example.  There is an option the send the reset value if disabling the 

pedal.  Also, an effect can turn a pedal function off when switching between A and B pedals.  You can choose to send the reset value when that happens. 

 

Pedals can turn on an effect automatically when in use, and turn them off when parked in the toe-down or heel-down position.  Click the effect label to 

choose an automatic effect.  For example, this could be used to automatically turn on a wah effect when the pedal is in use, then turn it off when parked in 

the toe-down position. 

Another popular example is to turn a tuner on when a volume pedal is set at the heel-down (volume off) position.  To do this, you'll need to set up a tuner 

effect with opposite on/off values:  The tuner effect CC ON value would be 0, and the OFF value 127.  That way, the tuner will be on when the pedal is in the 

heel-down position.  For the tuner effect, you may also wish to check the box "Display OFF as ON" so you see a green LED when the tuner is off. 

If you select an auto-effect that changes pedals from A to B, the effect will turn off the pedal change setting.  This prevents an auto-effect turning on an effect 

that changes pedal function. 

 

  



Onboard Pedal LEDs 
 

The TB-6P and TB-11P MFC models have an onboard pedal with built-in LEDs.  Here's what they show: 

 

The pedal position LED is blue by default, but you can assign a page LED colour of your choice to the pedal. 

  



Global Defaults 
 
Global settings should ideally be the first thing you set when you use MFC Edit for the first time. 

 

  



PATCH UP and PATCH DOWN 

 

If "Selected Patches for Patch Up/Down" is NOT checked … 

This means that Patch Up/Down footswitches scroll up and down through all patches. 

• Before a patch has been selected, either Patch Up or Patch Down select patch 0 in the current bank. 

• If you change banks (with a bank select footswitch, or Bank Up or Bank Down), the first press of either Patch Up or Patch Down selects the current 

patch number (0 to 9) in the new bank. 

• If the bank hasn't changed, then Patch Up/Down increases/decreases the patch number (0 to 9). 

You can uncheck "Patch Up/Down Can Change Bank" if you want to restrict patch up/down to the current bank.  For example: 

• If "Patch Up/Down can change bank" IS set, then Patch Up increases patches A8 > A9 > B0 > B1, changing the bank from A to B. 

• However, if "Patch Up/Down can change bank" is NOT set, Patch Up increases patches A8 > A9 > A0 > A1, wrapping around with no bank change. 

 

If "Selected Patches for Patch Up/Down" IS checked … 

This allows you to select which patches are used by Patch Up and Down.  The selection window allows you to select individual patches.  You can hold down 

[Ctrl] while clicking to select or deselect a column (same patch numbers), and hold down [Shift] to select or deselect a row (all patches in the same bank). 

When using selected patches for Patch Up and Down, it works the same way as "all patches" above, except that if the patch it tries to choose is NOT one of 

your selected patches, it continues searching for the next selected patch.  For example, say you are on patch A3 then change the bank to Bank B.  If you press 

a Patch Up footswitch it will try to choose patch B3, but if that is not a selected patch it will keep searching upwards for a selected patch.  Note that if you 

have restricted patch up/down to the current bank and if there are no selected patches in the current bank, then Patch Up/Down will do nothing. 

 

  



OTHER GLOBAL OPTIONS 

The option to "Send resets for effects … that exist in layout" is helpful if you have many effects available, but only want to send resets for those that are 

available in your footswitch layout.  This will send less reset messages after a patch change, but I recommend that you check that it works the way you 

intend. 

Patch Backtracking is used to toggle between the last two patches you used.  You can also backtrack: 

• Custom Settings allows you to select which effects, steppers, relay, control pedals and relays are restored when you backtrack 

• Effect States which includes effects off/on, stepper values, relays and Axe-FX tempo if set on the Axe-FX tab. 

• Pedal Positions which will restore your control pedals to what they were when you left the previous patch 

• Between Banks is used to allow or prevent backtracking between different banks 

  



Global Pedals & Pages 
 
This tab is used to set the different pedal types connected to your MFC.  Control pedals can have a "dead zone" at the toe-down and heel-down ends of their 

travel.  This is useful you can always get the full range of pedal values, even if you have a footswitch or rubber stopper under the pedal. 

You can also set which pages are used by the Page Up and Page Down footswitches.  Bear in mind that these footswitches will not stop on an empty page 

anyway. 

  



Global Display & Axe-FX 
 
This tab allows you to control what you see on your MFC's display.  Effect abbreviations can be set to show which effects are ON at the right side of the 

display.  There are also several options to set the editor skin (colour scheme) on the Tools menu. 

 



Notes Tab 
 
This tab allows you save notes with your settings.  Your notes are saved as a separate text file, with the same name as your settings file. 

 

 



Messages 
 
Several tabs allow you to customise which MIDI messages and MFC commands are sent.  The only ones that are mandatory are effect OFF and ON, and 

custom steppers if you use them.  These message boxes list each message and have 5 buttons at the right of the box: 

 adds a new message 

 is used to edit the currently selected message 

 removes the currently selected message 

and move the current message up and down 

 

When adding or editing a message, you'll see this window: 

 
 



The maximum size for all messages in each group is 255 bytes, however, messages can be chained.  For example, a patch message can use a MFC command 

to turn an effect ON, which will send that effect's ON messages.  That effect might use a MFC command to set a pedal value, etc. 

There is an option to set startup messages on the Global Defaults tab.  For this to work, your MIDI equipment must be up and running before you power up 

the MFC.  You should also consider what happens when if you have a power outage, because it's possible that the MFC will power up faster than your MIDI 

equipment, in which case, the startup message will be ignored. 

You can right-click on the message list to copy & paste messages.  When you copy a message, the MIDI message and MFC command data is also copied to the 

clipboard for those who want to examine this data. 

Settings Browser 
 
On the Tools menu, there is an option for the "Settings Browser".   The Settings Browser has several tabs that list common settings found in various locations 

in the main window.  This allows you to check for any possible conflicts without needing to navigate or scroll through different locations.   

The message browser tab shows all your messages, including any messages you've set up that are not used.  For example, you may have set up a custom 

message group for a patch, then decided later that the patch should use default messages instead.  Unused messages don't cause a problem, but you can 

remove unused messages in the message browser if you're sure you don't need them. 

Emulator 
 

Click the button on the toolbar to run the emulator, which opens a window to show how your MFC layout works.  It also shows MIDI messages that are 

sent.  Select your MIDI output device to use the emulator.  There is no MIDI input, so this is only used to test and show messages sent FROM your MFC. 

 



Axe-FX Tips 
 
This firmware supports Axe-FX II and Axe-FX III models.  Settings are on the Global Axe-FX tab.  There are examples below for various Axe-FX functions.  Also 
read the documentation for sample settings for more information including using the Axe-FX Looper controls. 
 

Getting Started 
 
Firstly, you need to connect MIDI OUT from the MFC to MIDI IN on your Axe-FX and connect MIDI OUT from your Axe-FX to MIDI IN on the MFC.  This allows 
them to “talk” to each other. 
 
There are also some Axe-FX settings to make: 
 

Axe-FX II:   

 - Press [I/O], the [PAGE >] to the MIDI tab, navigate to MIDI THRU and set it to OFF 

 - Press [I/O], the [PAGE >] to the MIDI tab, navigate to SEND REALTIME SYSEX and set it to ALL 

Axe-FX III: 

- Press [Setup], select [MIDI/Remote] then “General” tab, navigate to “Send Realtime Sysex” and set it to ALL 

 

Selecting a patch on the MFC will automatically request necessary Axe-FX settings.  Also, using an effect or stepper that synchronises with the Axe-FX will also 

automatically request Axe-FX settings.  To synchronise effects, use the Effects tab and select the “Set by Axe-FX …” option.  Likewise for steppers on the 

Steppers tab.  

 

  



Selecting Scenes with Effects 
 
Use Select type effects and put them in the same Effect group.  A typical ON message for a scene selection is Control Change number 34, value 0 (where the 
value is 1 less than the scene number).  There is no OFF message for scene selections.  Here's an example: 

 

 
 
This method has the advantage that the effect LED will show for the selected scene, and of course, the scene selection is applied to whatever Axe-FX preset is 
currently selected. 
 



Selecting Scenes with a Stepper 
 
When you first open MFC Edit, there is a Stepper already set up for scene selection.  You can use 2 footswitches (Scene Up and Scene Down) to scroll through 
scene numbers. 
 

Selecting Scenes with Patches 
 
If you only use one Axe-FX preset (or very few presets), you could use MFC patches to select Axe-FX scenes.  On the Patches tab, set "no MIDI Program 
Change", select "Custom Messages" and add the CC message you need to select your scene.  You can use MFC patch names to name your scenes with this 
method. 
 

  



Axe-FX Tips - Synchronising Axe-FX and MFC  

 

Synchronising Effect States 
 
When you select an Axe-FX preset, or change scenes, you want the MFC to show your Axe-FX states.  That way, you don't have to "double-press" effect 
footswitches to get them synchronised. 
 
There are 2 approaches to achieve this: 

• Get the Axe-FX to tell the MFC which effects are off and which are on. 

• Get the MFC to specifically set effect states when you select a patch with effect reset messages. 
 
You can combine elements of each if you wish.  Here are the advantages of each method: 
 

Axe-FX tells the MFC MFC tells the Axe-FX 

 

• Suits simple Axe-FX patches where effects are used individually. 
 

• If you often save changes to effect states in your Axe-FX presets, 
you don't have to manually keep your MFC effects states set the 
same. 
 

• Good if you often use Axe-FX scenes to change the state of 
several effects at once. 

 

• Allows you to use effects that don't just bypass a block.  For 
example, you may have a Reverb effect that changes a 
background ambient reverb into a big surf reverb. 
 

• Allows you to use a single effect footswitch that turn several 
effect blocks off and on at the same time.  For example you may 
wish to turn Chorus and Delay off/on together 
 

• Not all blocks have a bypass state (eg MIXER, MPX), so these are 
not supported by block messages 
 

• If you want to make sure your effect states turn off and on 
consistently with your MFC settings.  This is good for a live 
situation where you don't want to be surprised that you 
accidentally left some effects off/on when you last 
experimented with Axe-FX presets. 
 



 

MFC Tells the Axe-FX 
 
This method is used to have the MFC set effects off or on after a MFC patch change.  To use this option: 
 

• Use "Send messages with patch change" on the Effects tab, also on the Stepper tab if necessary 

• Set the most commonly used initial states (OFF or ON) on the Effects tab 

• If you have some patches that start with a different effect state, add a MFC command to the patch messages to set the effect off or on. 

 

Axe-FX Tells the MFC - Effects 
 
This method is used to have the Axe-FX tell your MFC which effects are off and which are on.   To use this option: 

1. On the Effects tab, click "Set by Axe-FX …" and select what you want to synchronise: scene number, channel number or bypass (off/on) state 
2. The default state (off, on or persistent) is used until information is received from your Axe-FX 

 



 

HOW THE MFC IDENTIFIES AXE-FX INFO 

• The first effect ON message must be a CC message that controls what you want to synchronise (scene number, effect channel or effect bypass). 
 

• For the Axe-FX III, the Axe-FX block is identified by the Block ID selected in step 1 above. 
 

• For the Axe-FX II, the Axe-FX block is identified by matching the CC number set on the Axe-FX (for bypass or X/Y channel) to the CC number in the first 
MFC effect ON message.  So Axe-FX II owners will need to take care if you use the same CC number for multiple effects, because the Axe-FX will report 
effect blocks on/off one at a time and there might be situations where one effect is on and another is off. 

 



HOW THE MFC SETS AN EFFECT OFF or ON 

 
When synchronising scenes, the Axe-FX scene number (1 to 8) matches an effect ON CC value 1 lower (0 to 7).   For example, if your first effect ON CC 
message is "CC number 34 value 3", the effect would be turned on if the Axe-FX is using scene 4. 
 
When synchronising Axe-FX III effect channels, effect blocks typically have 4 channels available (but can have more).  Axe-FX block channels A, B, C, etc 
match an effect ON CC value 0, 1, 2, etc.  For example, if your first effect ON CC message was "CC number 47 value 2", the effect would be turned on if the 
Axe-FX block is using channel C. 
 
When synchronising Axe-FX II effect channels, effect blocks typically have an X channel and a Y channel.  X matches a CC value of 0, and Y matches a CC value 
of 1. 
 
When synchronising Axe-FX effect bypass, the effect is turned on if the Axe-FX block is on, and the CC value is anything except zero.   
 
You can also use opposite values in the MFC if you want effects to work in reverse.  In this case you would have a CC value of 0 which would correctly show 
the MFC effect as ON if the Axe-FX block is OFF. 
 

Axe-FX Tells the MFC - Steppers 
 
This method is used to have the Axe-FX tell your MFC which stepper values apply after a MFC patch selection.  That way, you can continue to step up and 
down from the current Axe-FX value. 
 

1. On the Steppers tab, click "Set by Axe-FX …" then select what you want to synchronise: scene number or channel number (Axe-FX III only) 
2. The default value (start value or persistent) is used until information is received from your Axe-FX 
3. If you use the stepper to select scenes and you display a scene name on the MFC display, add a MFC command message to get scene name 
4. If you use the stepper to select scenes and effects or other steppers need to synchronise when you use this effect, add a MFC command message to 

Get Axe-FX Blocks  



HOW THE MFC IDENTIFIES AXE-FX INFO 
 

• Steppers that use CC values must have a lower limit of 0.  (Steppers using custom messages always have a lower limit of 1). 

• Steppers that get Axe-FX scenes or channels must have a high enough upper limit for the highest scene/channel you use.  For example, if you use all 8 
scenes, the upper limit must be 7 for a stepper using CC values, or 8 for a stepper using custom messages. 

• For the Axe-FX III synchronising a channel, the Axe-FX block is identified by the Block ID selected in step 2 above. 
 
HOW THE MFC SETS A STEPPER VALUE 
 
When synchronising scenes for a stepper using CC values, the Axe-FX scene number (1 to 8) sets a stepper CC value 1 lower (0 to 7).   For example, Axe-FX 
scene 4 would set stepper CC value 3. 
 
When synchronising scenes for a stepper using Custom messages, the Axe-FX scene number (1 to 8) sets the same stepper value 1 (1 to 8). 
 
When synchronising Axe-FX block channels for a stepper using CC values, Axe-FX blocks typically have 4 channels available (but can have more).  The Axe-FX 
channel A, B, C, etc sets a stepper CC value 0, 1, 2, etc.  For example, an Axe-FX block using channel C would set a stepper CC value of 2. 
 
When synchronising Axe-FX block channels for a stepper using Custom messages, Axe-FX channels A, B, C, etc sets a stepper custom message 1, 2, 3, etc.  
For example, an Axe-FX block using channel C would set a stepper custom message number 3. 
 

Axe-FX Tells the MFC - Details 
 
When you select a MFC patch, you can synchronise the following with your Axe-FX: 

• Effect and Stepper scene numbers 

• Effect block channel numbers 

• Stepper block channel numbers for Axe-FX III (for Axe-FX- II, use a toggle effect for block X/Y channels) 

• Effect block bypass (off/on) states 

• Looper modes 
 

As mentioned above, the MFC will request information from your Axe-FX automatically when needed.  Here's how: 

• If you are using tempo backtracking, the MFC will get Axe-FX tempo after each patch change, and after the tap footswitch is released.  This allows 

patch backtracking to set the previous patch's last used tempo. 

• If you are displaying an Axe-FX preset name on the MFC's LCD, the MFC will get the Axe-FX preset name after a MFC patch change. 



• If you are displaying an Axe-FX scene name on the MFC's LCD, the MFC will get the Axe-FX scene name after a MFC patch change.  If you use an effect 

or stepper to select scenes, you can add a "Get Scene Name" message to request and show it on the MFC. 

• If you set effects or steppers to set their state to match your Axe-FX scene after a MFC patch selection, the MFC will request the Axe-FX scene number 

• If you set effects or steppers to set their state to match your Axe-FX block state or channel after a MFC patch selection, the MFC will request the Axe-

FX block information. 

This information is requested automatically after a MFC patch selection when you have an Axe-FX model selected in you MFC settings.  You can also get this 

information manually by adding MFC Command messages.  For example, if you have an effect or stepper that selects scenes, you could add messages to get 

the scene name and Axe-FX blocks. 

Note that when you get Axe-FX preset and scene names, you might see the MFC display briefly flash MFC bank and MFC patch names.  These are the default 

displays in case information is not received from the Axe-FX. 

Axe-FX requests are always sent after all other MIDI messages have been sent, in this order:  

 Get Block States,  Get Tempo,  Get Preset Name,  Get Scene Name 

For example, say you have an effect that sends these messages (with the Axe-FX requests shown in red): 

• Some MIDI messages 

• Get Tempo  

• Select a Stepper Start value 

o and the Stepper messages are … 

o Get Scene Name 

o Some MIDI messages 

o Get Tempo 

• then the effect messages continue with … 

• Get Block States 

• More MIDI messages 

The MFC will first send all MIDI messages, and will then send requests to your Axe-FX, in this order: 

 Get Block States, Get Tempo, and Get Scene Name (only once each).  



Axe-FX Tips - Showing Tap Tempo 
 

The Axe-FX must be set to send tempo via its system exclusive messages.  See the Axe-FX documentation for instructions on how to set that. 

In the MFC editor, set "Show Tempo on Tap Footswitch" on the Global Display & Axe-FX tab.  If your Tap effect does not have a 2nd effect, tap tempo will 

always display on the tap footswitch LED.   A 2nd effect is one that's turned on after a certain number of tap presses after a patch selection, so if you use one 

(for example, to turn on delay), tap tempo will display when the 2nd effect is turned on. 

 

Axe-FX Tips - Showing Tuner 
 

The Axe-FX must be set to send the tuner via its system exclusive messages.  See the Axe-FX documentation for instructions on how to set that. 

In the MFC editor, set "Show Tuner Automatically" on the Global Display & Axe-FX tab.  Whenever you select the tuner on the Axe-FX, or send a message 

from the MFC, the tuner will display along the bottom row of your MFC's display.  It will also revert automatically to the normal MFC display when the tuner 

is turned off.  



Limitations 
 
The editor prevents some selections that don't make sense, and there are some basic limits: 
 

• There must be at least one bank defined 

• There must be at least one effect (the Tap effect), one stepper and one pedal defined 

• 8 footswitch pages, 25 patch banks (each with 10 patches), 100 effects, 25 effect groups, 25 steppers, 25 control pedals 
 

The [Ctrl] Key 
 
You can select several options in the Editor while holding down the [Ctrl] key.  This generally makes a bigger change than just selecting an option.  Here are 
the main ones you will find useful: 
 

• If there is more than one message in a message group, you can hold down Ctrl and click the Remove button to delete all messages in the group. 
 

• On the Patches tab there are options for what to do when selecting the current patch again:  Reset the patch, backtrack, etc.  If you hold down [Ctrl] 

while clicking on an option that is already selected, you'll see a dialog that allows you to set some or all other patches to the same option.  This is a 

real time-saver if you have a lot of patches to change. 

 

• The patch selection window can sometimes be used for multiple patch selection (such as choosing patches that an override applies to, or patches that 

are selected for Patch Up and Down footswitches).  For multiple selections, you can still choose patches individually.  You can also hold down [Ctrl] 

while clicking to select or deselect a column (same patch numbers), and hold down [Shift] to select or deselect a row (all patches in the same bank). 

 

• On the Layout tab, when viewing Overrides, you can hold down Ctrl and click Remove to remove ALL overrides. 
 

• In the Message Browser, if you have unused messages, you can go to an unused message, hold down [Ctrl], then click "Remove" to remove all unused 
message groups. 
  



Terminology 
 

MFC 

MIDI Foot Controller 

 

LCD 

Liquid Crystal Display - the text display on your MFC 

 

Groups 

There are several types of groups used in MFC edit: 

An override group is one or more patches with footswitch and/or pedal overrides that apply to those patches.  Overrides can be for footswitches on any page 

and for any model.  You can click the overrides label (below the Remove button) to see a list of overrides in use. 

An effect group is used by toggle and select effects to ensure that only one effect is ON in the group at a time.  Turning on an effect in the group will turn off 

other effects in the same group. 

A message group is shown in message boxes on several tabs.  It is just the collection of all messages listed. 

 

Toggle and State 

Toggling is something that swaps between two settings.  For example, a toggle effect is controlled by pressing once to turn on, then press again to turn off.  

State just means whether the effect is off or on. 

 



Patch vs Program vs Preset 

These words have similar meanings, and different manufacturers have their own preferences.  For this MFC used with an Axe-FX: 

The MFC has up to 250 patches (10 patches per bank in up to 25 banks); only one is selected at a time.  Selecting a MFC patch typically sends a MIDI program 

message (MIDI allows 128 program numbers, or more if you use MIDI MSB and LSB banks).  The MIDI program message selects a preset on the Axe-FX, which 

is a collection of settings for effects, amp and cab simulators, etc. 

 

Banks 

Each bank in the MFC has 10 patches which you can assign to footswitches.  A MFC patch normally sends a MIDI program change message which can 

optionally be combined with MIDI Bank messages. 

MIDI banks are split into 2 components called MSB and LSB.  You can calculate the combined MIDI bank number = (MSB x 128) + LSB.  These banks allow you 

to select more presets in your equipment than just the 128 allowed by MIDI program changes alone.  For example, the Axe-FX uses just the MSB to select its 

preset banks, while the Kemper uses only the LSB.  Synthesizers often use both MSB and LSB to allow you to select from a large number of preset sounds. 

Your MIDI equipment will often have presets split between banks, but you’ll need to read the documentation to learn what MIDI message banks are required. 

 

Default 

Default just means the most commonly used setting, or the setting that will be used unless changed elsewhere. 

 

Block 

A block represents an Axe-FX effect, such as a chorus or reverb effect, amp simulator and cab emulator.  



MFC Setup 
 
Control pedals are configured directly on your MFC, without using the editor. 
 

Pedal Calibration 
 
This should be done the first time you use the MFC and whenever you change pedals. 
 
1. On the MFC, press [SETUP] then use [UP] and [DOWN] to select calibration for one of your pedals.  Only configured control pedals will show here. 

 
2. Make sure the pedal is connected and press [RIGHT] to start. You can choose several options here with [UP] and [DOWN]: CALIBRATE is used to set the 

range of your pedal / TAPER allows you to compensate for non-standard pedal tapers / RESET restores your current settings for the selected pedal 
 

3. When calibrating, you'll first see the current minimum and maximum pedal values, then the actual pedal value. Sweep the pedal a few times from 
minimum to maximum to set its range.  You can press [RIGHT] if necessary to restart the calibration. 
 

4. Then press [LEFT] to return to the options menu, and [LEFT] again to return to the pedal selection menu.  Repeat for the other pedal(s) if necessary, then 
save your settings with [OK], or press [NO] to exit without saving.  

 



Pedal Failures 
 
Pedals are subject to failure or temperamental behaviour due to scratchy pots, mechanical problems and connecting cable faults. The quick fix to disable all 
pedals is to press [OK] twice - you could even do this in the middle of a solo!  
 
These changes are temporary - all pedals will be active the next time you power up your MFC. 
 
 
 
HOW IT WORKS 
 
Pressing [OK] displays a screen to disable ALL pedals. You can press 
[UP] and [DOWN] to scroll through options to disable just one pedal.  
 
Press [LEFT] to toggle between disabling and enabling pedals. 
 
You can press [RIGHT] to view which pedals are currently active. 
 
Press [OK] again to disable (or enable) the selected pedal(s).  If 
configured, this will also send a reset value for the pedal(s), for 
example, maximum volume for a faulty volume pedal.  
 
Press [NO] to exit this screen without making changes.  
 
Only pedals configured as control pedals or BS-2 footswitches will 
show here. 
  
 

  



MIDI OUT Options 
 
When you first power on the MFC, it is set to send MIDI out via the standard DIN socket on the back of the MFC, labelled "MIDI OUT".   
 
You can press the UP button on top of the MFC to toggle between sending MIDI OUT via USB or the DIN socket. 
 
If sending MIDI output via USB, you will need to follow the instructions from the factory firmware manual to receive MIDI on your computer.  They are 
reprinted here: 
 

BJ Devices TB-series midi controllers have an USB interface for connection to a computer, but are not PC-compatible MIDI devices. In order to use the controller as a 
MIDI device via USB, follow these steps: 
 
1. Install serial to midi converter Hailess MIDI  http://projectgus.github.io/hairless-midiserial/ 
 
2. For Windows install virtual MIDI port LOOPMidi(not needed for MAC): 

http://www.tobias-erichsen.de/software/loopmidi.html 
 

3. For MacOs enable the “IAC” virtual MIDI port. Applications→Utilities→“Audio MIDI Setup”→“Show MIDI Window”→“IAC Driver”.  Check the “Device is online” box 
in the dialog that appears. 
 

4. Install USB-COM driver (in most cases this installation starts automatically) http://www.ftdichip.com/Drivers/VCP.html 
 

5. Run Hairless MIDI↔Serial Bridge, then … 
- choose COM port which is according TB-series controller COM port 
- assign COM port to midi OUT device LOOPMidi(or IAC for MacOs) 
- set baud rate to 56000 

 

Manual Page Change 
 

The LEFT and RIGHT buttons on the MFC change pages manually.  This can be useful if you have more than one set of pages you use for different purposes.  

For example you might use pages 1, 2 & 3 for patches, scenes and effects and use a footswitch to select between pages 1, 2 & 3.  You might want to also use 

page 4 alone for looping and effects only with no page changes for a different type of performance. 

http://projectgus.github.io/hairless-midiserial/
http://www.tobias-erichsen.de/software/loopmidi.html
http://www.ftdichip.com/Drivers/VCP.html


About Effects 
 

Where Are My IAs? 
 
IA is a term sometimes used for MIDI messages that toggle an effect on and off. There is no such thing as a MIDI "IA" message, so I use the correct term: CC 
for control change. This is also more applicable to my firmware that can send any value for off and on.  
 

Why Can't I Choose CC Numbers 0 and 32? 
 
Well firstly, the MFC does send CC message numbers 0 and 32 - they're the MSB and LSB bank numbers on the Patches tab. They are used to access more 
than 128 patches on connected equipment.  
 
CC numbers 0 and 32 are reserved for MIDI patch banks, so they're not available as effect controller numbers. Using those numbers for effect controllers can 
cause unpredictable patch selection in connected equipment. Any other number from 1 to 31 and 33 to 127 can be used.  
 

  



Notes 

 

Bugs 
 
There are no known bugs with the settings I use. But with so many possible setting combinations it is not possible to test every scenario. I'm keen to make 
sure the firmware and editor work as described, so please let me know if you find any problems at info@gmarts.org 
 

Disclaimer 
 
GM Arts takes no responsibility whatsoever for the consequences of use or attempted use of the editor or firmware. 
 

Purchase 
 
The GM Arts Firmware and Editor are provided free of charge for use as-is. 
 
BJ Devices MIDI Foot Controllers can be purchased from http://www.bjdevices.com/en/ 
 

mailto:info@gmarts.org
http://www.bjdevices.com/en/

